Tutorial de configuracdo do ambiente de desenvolvimento
Android com Eclipse

DOWNLOAD DO ECLIPSE

Baixe a versdo Neon do eclipse em: http://www.eclipse.org/neon/

DOWNLOAD DO JDK

Baixe 0 JDK 8u91 em:
http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-
2133151.html

¢ Role a pagina para baixo até encontrar a seguinte tabela

e Marque a opgao “Accept License Agreement”

e Clique no link: “jdk-8u91-windows-x64.exe” (caso seu PC seja 64 bits)
o Ouem: “jdk-8u91-windows-i586.exe” (caso seu PC seja 32 bits)

JDK 8u91 Checksum
JOK 8u82 Checksum

Java SE Development Kit 8u91

You must accept the Oracle Binary Code License Agreement for Java 5E to download this

Windows x86 182.29 MB
Windows x64 187.4 MB

software.
* O Accept License Agreement ® pecline License Agreement
Product / File Description File Size Download
Linux ARM 32 Hard Float ABI 7 72MB  jdk-8u81-linux-arm32-fp-hflt.targz
Linux ARM 64 Hard Float ABI 7469 MB  jdk-Bu9i-linux-armG4-fp-hflttargz
Linux x286 15474 MB  jdE-Bu91-linux-iS86.rpm
Linux x86 17492 MB  jdk-8u81-linux-i586.tar.gz
Linux xG4 15274 MB  jdk-8u8i-linux-x64.rpm
Linux x64 17297 MB  jdk-8u91-linux-x64 targz
Mac 05 X 22729MB  jdk-Bu91-macosx-xG4.dmg
Solaris SPARC 64-bit (SVR4 package) 13959 MB  jdk-S8u81-solaris-sparcvd tars
Solaris SPARC 64-hit 93.95MB  jdk-8u91-solaris-sparcvd targz
Solaris x64 (3VRE4 package) 14029 MB  jdk-Bu91-solaris-xGd tard
Solaris x64 9678 MB  jdk-Bu81-solaris-x64 targz
jdk:
jdk:

dk-8u91-windows-i586.exe (
dk-8u81-windows-x64 exe



DOWNLOAD DO ANDROID SDK

Baixe o0 Android SDK em: https://developer.android.com/studio/index.html#downloads

¢ Role para baixo até encontrar a seguinte tabela
e Clique no link: “installer r24.4.1-windows.exe”

Get just the command line tools

If you do not need Android Studio, you can download the basic Android command line tools below.

Windows installer_r24.4.1-windows.exe 144 MB f9b59d72413649d31e633207e31f456443e7ealb
(151659917 bytes)
android-sdk_r24.4.1-windows.zip 190 MB 66bbab433053¢c152b22bf8cab19c0f3fef4ebadg
No installer (199701062 bytes)
Mac 0S X android-sdk_r24.4.1-macosx.zip 98 MB 85a%¢ccch0b1f9e6f1f616335¢5f07107553840cd
(102781947 bytes)
Linux android-sdk_r24.4.1-linux.tgz 311 MB 725bb360f0f7d04eacctf5a2d57abdd49061326d

(326412652 bytes)

Also see the SDK tools release notes.

e Marqgue o checkbox
e Clique no botdo de download

Download the Ccmmand Line Tools

Befare downloading, you must agree to the following terms and conditions.

Terms and Conditions

This is the Android Software Development Kit License Agreement

1. Introduction

1.1 The Android Software Development Kit (referred to in the License Agreement as the "SDK" and specifically
including the Android system files, packaged APls, and Google APls add-ons) is licensed to you subject to the terms
of the License Agreement. The License Agreement forms a legally binding contract between you and Google in

relation to your use of the SDK

1.2 "Android" means the Android software stack for devices, as made available under the Android Open Source

Project, which is located at the following URL: http://source.android.com/, as updated from time to time.

[ 1 have read and agree with the above terms and conditions




INSTALE O JDK

Siga 0s passos a seguir:

8 Java SE Development Kit & Update 91 (64-bit] - Setup

X 8 Java SE Development Kit 8 Update 91 (64-bit) - Custom Setup X

Welcome to the Installation Wizard for Java SE Development Kit 8 Update 91

This wizard will quide you through the installation pracess for the Java SE D t

Select optional features to install from the list below. You can change your choice of features after
installation by using the Add/Remove Programs utility in the Control Panel

Feature Description

Kit & Update 91,

The Java Mission Control profiling and diagnosti
the JDK.

ols suite is now available as part of

Java SE Development Kit &
Update 91 (64-bit), induding the
JavaFX SDK, a private JRE, and
the Java Mission Contral tools
suite. This will require 130MB on
your hard drive.

Source Code
+| Public JRE

. Development Tools

Install to:
C:\Program Files\Javatjdk1.8.0_91\

Instalagdo do Java - Pasta de Destino -

| <Back [ Mest> || Concel |

K 1) Java SE Development Kit 8 Update 91 (64-bit) - Complete X

Pasta de Destino

Clique em "Alterar.." para instalar o Java em outra pasta.

D\

Instalar em:
C:\Program Files\Java\jre1.8.0 91

Java SE Development Kit 8 Update 91 (§4-bit) Successfilly Installed

Click Next Steps to access tutorials, API documentation, developer guides, release notes
and more to help you get started with the JDK.

D\

MNext Steps

‘ < Voltar | | Préximo >

INSTALE O SDK

Na tela para escolher o local de destino, clique no botao “Browse...”

Crie uma pasta chamada “androidSDK” no disco local C

(&) Android SDK Tools Setup

Choose Install Location
Choose the folder in which to install Android SDK Tools.

@ Procurar Pasta

Select the folder to install Android SDK Tools in:

“am Disco Local (C:)

Setup will install Android SDK Tools in the following folder. To install in a different folder, dick

Browse and select another folder. Click Next to continue.

> Android
Android_Studic
android5DK
> android-sdk
> Arquivos de Programas
> Arquivos de Programas (x86)

> EasyPHP-16.1

> eclipse
flexlm
Destination Folder > HD
[ c:landroidsoky | [ Browse.. { > L Intel
Logs
PerfLogs
Space required: 316.4MB > PROGRAMAS
Space available: 240.5GB 3 ProgramData
> Riot Games
Mullsoft Install System w02-Oct-2015, cvws
< Back ” Next > | | Cancel | | Criar Mova Pasta oK. I | Cancelar




Na ultima tela desmarque o checkbox “Start SDK Manager” e clique em finish

IZ) Android SDK Tools Setup —

Completing the Android SDK Tools
Setup Wizard

Android 50K Tools has been installed on your computer.,

Click Finish to dose this wizard,

|| Start SDK Manager {to download system images, etc.)

INSTALE O ECLIPSE

No instalador do Eclipse, escolha a opc¢éo: “Eclipse IDE for Java Developers”.

Depois clique no botdo de instalacéo.

eclipse

eclipse

\ Q
_ ~ | Eclipse IDE for Java Developers
‘_1; Ec"Pse IDE forjava Developers @) The essent al tools for any Java developer, including a Java IDE, a Git client, XML
7 The essential tools for any Java developer, including a Java IDE, a Git client, XML Editor, Mylyn, Maven and Gradle integration.
Editor, Mylyn, Maven and Gradle integration
e Eclipse IDE for Java EE Developers |nstallation Folder .

g . . o
i@ Tools for Java developers creating Java EE and Web applications, including a Java
DE, tools for Java EE, JPA, JSF, Mylyn, EGit and others.
"  create start menu entry

- ' create desktop shortcut
~ Eclipse IDE for C/C++ Developers \ ‘
=
E-
L Y An IDE for C/C++ developers with Mylyn integration.

q Eclipse IDE for JavaScript and Web Developers

The essential tools for any JavaScript developer, including JavaScript language
support, Git client, Mylyn and editors for JavaScript, HTML, €SS and XML.

Eclipse IDE for PHP Developers

-
@ The essential tools for any PHP developer, including PHP language support, Git

client, Mylyn and editars for JavaScript, HTML, CSS and XML, < BACK



Terminada a instalacdo, clique em “Launch”, isso ird abrir o Eclipse.

eclipse

S

by Oomph

Eclipse IDE for Java Developers

The essential tools for any Java developer. including a Java IDE, a Git client, XML
Editor, Mylyn, Maven and Gradle integration.

Installation Folder  C:\Program Files\java-neon

&/ create start menu entry

\/ create desktop shortcut

» LAUNCH

show readme file
open in system explorer

keep installer

£ BACK

Na nova tela clique no botao “Browse...” e crie a pasta
“Documentos”

“workspaceAndroid” na pasta

Marque o checkbox “Use this as the default and do not ask again”, depois clique em OK

£ Eclipse Launcher

Select a directory as workspace

*

Eclipse uses the workspace directory to store its preferences and development artifac.

Workspace: | C:h\Users\Marcelo Junior\workspace

v | | Browse...

[[]Use this as the default and do not ask again

oK

Select Workspace Directory

Select the workspace directory to use.

=| Documentos L]

v @ Documentos

Adobe
documentos
EclipseProjects
IFRN

IGREJA

IMAGENS
JAPOMNES

JOGOS

League of Legends
livros

Modelos Personalizados do Office
MetBeansProjects

\

| workspaceAndroid

waorkspacefndroid

Pasta:

Criar Mova Pasta Cancelar

Cancel



CONFIGURANDO O ANDROID NO ECLIPSE

Escolha 0 menu: Help > Install New Software...

& workspaceAndroid - Java - Eclipse
File Edit Mavigate Search Project Run Window Help

(%) Welcome 52 @) Welcome
Help Contents
Search

Show Contextual Help

Show Active Keybindings... Ctrl+Shift+L
Tips and Tricks...
Report Bug or Enhancement...

Cheat Sheets...

=

Review the IDE's m¢ Perform Setup Tasks...

Check for Updates
Install New Software...

B

A guided walkthroug Installation Details

Eclipse Marketplace...

0 &@od &

About Eclipse

Clique em “Add...”

Na caixa que aparece, digite “Android” no campo “Name:” e cole 0 endereco
“https://dl-ssl.google.com/android/eclipse/” no campo “Location”, como segue:

£ Add Repository *
MName: | Android | Local...
Location: | http5:_»'_a'd|-55I.googIe.coma’android;’eclipsaﬂ | Archive...

Marque o checkbox “Developer Tools” e clique em “Next >”

2 Install o X

Available Software
D =

Check the items that you wish to install

Workwith: [ Android - https://dI-ssl.google.com/android/eclipse/ v] Add...

Find more software by working with the "Available Software Sites" preferences.

type filter
MName Version

[] 100 Developer Tools
P!

Select All Deselect All 6 iterns selected
Details
Show only the latest versions of available software [ Hide items that are already installed
Group items by category What is zlready installed?

[ Show only software applicable to target environment
[ Contact all update sites during install to find required software

(@' < Back Next > Einish Cancel



Em “Next >” novamente, e depois aceite 0s termos da licenga e depois “Finish”

© s o x
Install Details '7
Review the fems o be instaled ¢ reveesd and accepted belore the st a‘-

Nersion License st

20721208 “Apache License 5

20721208 i Software User Agreement fersion 20, January 2004

it /e pache ary/lcenses

oo 20721208 2jo i mder e BSD cense rtherthon the APL Vou canfinl| 165415 4D CONDITIONS FOR USE, REPRODLICTION, D
207212088 Miote: kxmi2-2.3.0jar s undes the BSD lcemse ather than the EPL. You canfind s c0 | DISTRIEUTION
20721208

with that entity. For the purpases of this definr

Size: Unknown
Datis . .
@ ) gccept he e of the
x < 3| )1 do not accept the terms of the bcense agreements. ’

g ] e = 2 <hack " o

Se aparecer a seguinte mensagem de aviso, pode clicar em “OK”

S Security Warning O *

Warning: You are installing software that contains unsigned content. The authenticity
& I . orvalidity of this software cannot be established. Do you want to continue with the

installation?

Quando aparecer a mensagem pedindo para reiniciar o Eclipse, clique em “Yes”

& Software Updates pd

You will need to restart Eclipse for the changes to take effect. Would you like to
restart now?

Depois que reiniciar o eclipse, acesse o menu: Window > Preferences

& workspaceAndroid - Java - Eclipse
File Edit Refactor Mavigate Search Project Run  Window Help

5' () Welcome 2 New Window
. Editor >
Py Overview Appearance ’
Show View »
Perspective ¥
Navigation >

|‘--€- Android SDK Manager
- Get familiar with the D Android Virtual Device Manager

Run Andreid Lint »

Preferences




Na nova tela, no lado esquerdo, selecione “Android”, clique em “Browse...” ¢ localize a
pasta “androidSDK” no disco local C

| & Preferences o X Procurar Pasta x
t}pefiltertm’ € Could not find folder 'toals' inside SDK 'C:\'. e
General ‘
‘ Android Android Preferences
| Android Emulator SDK Location: | | | Browse... m Videos o
Ant Note: The list of SDK Targets below is only reloaded once you hit ‘Apply’ or 'OK'. ~ i Disco Local (C)
C/C++ = :
Code Recommenders Target Name Vendor Platform  APl... Andraid
Data Management Android 4.2.2 Android Open Source Project 422 17 Android_Studio
Help Android 4.3.1 Android Open Source Praject 431 18 ~ | androidSDK
Install/Update Google APl Goagle Inc. 431 1 add-ons
| Java Android 4.4.2 Android Open Source Praject 442 19
Maven platforms
M Anal Google APls (x86 Sys... Google Inc. 442 19
MEImDW nayzer Android 6.0 Android Open Source Project 6.0 23 tools
n .
O:n)':ph Android N (Preview)  Android Open Source Project N N android-sdk
Plug-in Development Arquives de Programas
Run/Debug Arquivos de Programas (x868)
Team EasyPHP-16.1
Validation eclipse
KML
flexlm
HD
1 L ¥
|
1 Restore Defaults Apply Pasta: | androidsDK
@ @ oK Cancel Criar Nova Pasta Cancelar
: 113 ’9
Clique em “OK” nas duas telas...
Acesse 0 menu: Window > Android SDK Manager
£ workspaceAndroid - Java - Eclipse
File Edit Refactor Mavigate Search Project Run | Window  Help
= B F
- | @ Welcome 57 Mew Window
Editor *

[] )
%} Ovewlew Appearance *

Show View *
Perspective *
Mavigation »

=, Android SDK Manager
m“'l
Get familiar with the (5] Android Virtual Device Manager
Run Android Lint »

Preferences

O Android SDK Manager ira carregar as bibliotecas

3 Android SDK Manager - o X
Packages Tools
SDK Path: CihandroidSDK

Packages
' Name API Rev.  Status ~
~ [0 Teols

[].# Andreid SDK Tocls 2441 i Update available: rev. 25.1.7
.4 Android SDK Platform-tools 24
O+ Android SDK Bui 24
[0 Android SDK Bui 2303
[ Android SDK Bui 2302
[0+ Android SDK Bui 201
[0+ Android SDK Bui 2201
[+ Android SDK Bui 2112
.4 Android SDK ui 20
[+ Android SDK Bui 191
~ [ Tools (Preview Channel)
[+ Android SDK Tools 2517
[1.# Android SDK Platform-tools 243 v

Show: ] Updates/New [ installed  Select New or Updates Install packages...

[] Obsolete Deselect All Delete packages...

I

O =

Fetching URL hitps://dl.google.com/android/repository/extrasfintel/adden.xml



Na pasta “Tools”, deixe marcado como segue:
Android SDK Manager - O b4

Packages Tools
SDK Path: C:handroidSDK

Packages
i Name AP Rev.  Status &
v [ | Tools
" Android 5DK Tools 2441 g Update available: rev. 25.1.7
" Android SDK Platform-tools 24 | Not installed
Android SDK Build-tools 24 [ Not installed
O] 4" Android SDK Build-tools 2303 [ Not installed
]+ Android SDK Build-tools 23.0.2 [ Not installed
]+ Android SDK Build-tools 23.0.1 [ Not installed
]+ Android SDK Build-tools 2201 [ Not installed
[0 +" Android SDK Build-tools 21.1.2 [ Not installed
[0+ Android SDK Build-tools 20 [ Not installed
[0+ Android SDK Build-teols 191 [ Not instatlled

DE; Android N (API 24)
[JE2 Android N (API 23, N preview)

[T1E2 Android 6.0 (API 23) v
Show: [v] Updates/MNew Installed  Select Mew or Updates Install 4 packages...
[]Obsolete Deselect All Delete 1 package...

M

Done loading packages.

Minimize todas as versdes do android e deixe marcado como segue:

Android SDK Manager - O *

Packages Tools
SDK Path: C:\androidSDK

Packages

I Name API Rev.  Status "
0| Tools
CIC2 Android N (API 24)
1L Android M (API 23, N preview)
[JC2 Android 6.0 (API 23)
[JC2 Android 5.1.1 (API 22)
[JC2 Android 5.0.1 (AP1 21)
[ Android 4.4W.2 (AP 20)
[1C2 Android 4.4.2 (API 19)
[1C2 Android 4.3.1 (API 18)
[ Andreid 4.2.2 (AP117)
[1C2 Android 4.1.2 (API 16)
[1C2 Android 4.0.3 (API 15)
[1C2 Android 4.0 (API 14)
1L Android 3.2 (API 13)
[JC2 Android 3.1 (AP112)
[JC2 Android 3.0 (AP1 11)
[JC2 Android 2.3.3 (API 10)
[JC2 Android 2.3.1 (API19)
CIC2 Android 2.2 (API 8)
D[; Android 2.1 (API7)
~ [ Extras

Ml &= A0 Nehimming tnnle 21 Mt inctallad
Show: [] Updates/New [ Installed  Select New or Updates Install 41 packages...
[]Obsolete Deselect All Delete 1 package...
M w

Done loading packages.



Na pasta “Extras” deixe marcado como segue e depois clique no botéo de instalacéo

Android 5DK Manager

Packages Tools

SDK Path: C:\androidSDK

Packages

I§ Name
[JC Android 2.2 (AP 8)
[JE2 Android 2.1 (API 7}
v [ Extras

[] &3 GPU Debugging tools

[ B8 GPU Debugging tools

[ E3 Android Support Repository

[ &3 Android Auto Desktop Head Unit emulator
[] &3 Google Play services

[ 7 Google Repository

[ &3 Google Play APK Expansion library
[] &3 Google Play Licensing Library

[ &3 Google Play Billing Library

] &3 Android Auto AP Simulators

3 Google USB Driver

[ & Google Web Driver

[ £3 Intel x86 Emulator Accelerator (HAXM installer)

API Rev.

31
103

Show: [#] Updates/Mew [] Installed Select New or Updates

[] Obsolete

Deselect All

Done loading packages.

Status

Not installed
Not installed
Not installed
Mot installed
Mot installed
Mot installed
Not installed
Not installed
Not installed
Not installed
Mot installed
Mot installed
Not installed

Aceite os termos de licencga e clique em “Install”

Choose Packages to Install

Packages

b

Android SDK License ~
¥, Android SDK Tools, revision 25.1.7
¥, Android SDK Platform-tools, revisi
¥4 Android SDK Build-tools, revision .
¥ SDK Platform Android 4.4W.2, AP
¥ SDK Platform Android 4.4.2, AP| 1¢
¥ SDK Platform Android 4.3.1, API 1€
¥ SDK Platform Android 4.2.2, API 17
¥ SDK Platform Android 4.1.2, AP| 1€
¥.¢ SDK Platform Android 4.0.3, API 12
"’x SDK Platform Android 4.0, AP1 14,
¥, Android Wear ARM EABI v7a Syste
¥.¢ Android Wear Intel x86 Atom Syste
¥ ARM EAEI vTa System Image, And
¥ Intel x86 Atom Systern Image, And

¥, Google APls ARM EABI wTa Systemr
V. Gnnnle ADlc Intal AR Atnm Suctary ©

Package Description & License

Packages
- Android 5DK Tools, revision 23.1.7

*

Install 41 packages...

Delete 1 package...

o =)

- Android SDK Platform-tools, revision 24

- Android 5DK Build-tools, revision 24

- SDK Platform Android 4.4W.2, APl 20, revision 2

- SDK Platform Android 4.4.2, AP1 19, revision 4

- SDK Platform Android 4.3.1, AP 18, revision 3

- SDK Platform Android 4.2.2, API 17, revision 3

- SDK Platform Android 4.1.2, API 16, revision 3

- SDK Platform Android 4.0.3, API 15, revision 3

- SDK Platform Android 4.0, APl 14, revision 4

- Android Wear ARM EABI v7a System Image, Android AP 20, revision 4
- Android Wear Intel xB6 Atom System Image, Android AP| 20, revision

4

- ARM EABI| v7a System Image, Android APl 19, revision 3

- Intel x86 Atom System Image, Android API 19, revision 3

- Google APls ARM EABI w7a System Image, Android API 19, revision 21

- Google APls Intel x86 Atom System Image, Android AP| 19, revision 20 w

Accept

Reject

Copy to clipboard | Print

() Accept License

Install Cancel



CRIANDO PROJETO “helloWorld”

Acesse: File > New > Project

& workspaceAndroid - Java - Eclipse
File Edit Refactor MNavigate Search Project Run  Window Help

New Alt+Shift+N > 2% Java Project
Open File... = Project...

[ Open Projects from File System... B Package
Close Ctl+W | & Class
Close All Ctrl+Shift+W | @ Interface
Save Cutes | @ Enum
Save As.. @ Annotation
Save Al Ctrl+Shift»s | #J Source Folder
Revert 48 Java Working Set

1 Folder

Move... ¢ File
fename... F = Untitled Text File
e ) o = £ JUnit Test Case
Convert Line Delimiters To ¥ & Task
Print... Ctrl+P I Bample.
Switch Workspace ¥ 5 Other.. CrleN
Ractart

Selecione “Android Application Project” e clique em “Next >”

£ New Project m] x
Select a wizard —

Create an Android Application Project

Wizards:
type filter text

(= General
v (= Android

{2 Android Application Project
% Android Project from Existing Code
2 Android Sample Project
Jii Android Test Project

= C/C++

(= Gradle

= Java

(= Maven

(= Examples

@ < Back Next > Finish Cancel

Preencha os campos como segue: e Android Aplcain 5 x
New Android Application 4
i\, The application name for most apps begins with an uppercase letter @

Application Name: | helloWorld |

Project Name: helloworld Prjec Names2 helotiond |

Package Name:a| com.teste.helloworld |

Application Name: helloWorld

PaCkage N ame: com.teste. hel Ioworl d Minimum Required SDK:3| API 14: Android 4.0 (ceCreamSandwich) v

Target SDK:® AP 17: Android 4.2 (Jelly Bean) ~

H% Y H . Ci ile With:® AP|17: Android 4.2 (Jelly Bean) ~
Minimum Required SDK: API 14... e —

Theme:® Holo Light with Dark Action Bar ~

Tal‘get SDK API 17  Choose the highest AP| level that the application is known to work with. This attribute informs the system

that you have tested against the target version and the system should net enable any compatibility behaviers
to maintain your app's forward-compatibility with the target version. The application is still able to run on
older versions {down to minSdkVersion). Your application may laok dated if you are not targeting the current

Compile With: API 17...
Theme: Holo Light with Dark Action Bar

@ < Back Next > Ereh Cancel

E cliqgue em “Next >”



Deixe esta tela como esté e clique em “Next >”

£ New Android Application o X

New Android Application

Configure Project @

[ Create custom launcher icon

[ Create activity
] Mark this project as a library

Create Project in Workspace

C:\Users\Marcelo Junior\ Documents\workspaceAndroid\helloWorld Browse...
Working sets
[ Add project te working sets New..
Select...
@ <Back [ Next> Finish Cancel

Agora pesquise na internet por uma imagem do planeta, esse sera o icone de nossa
aplicagéo.

Clique no botédo “Browse...” e localize a imagem do planeta que acabou de baixar e
cligue em “Next >”

2 New Android Application

Configure Launcher Icon

Configure the attributes of the icon set @

Preview:
Foreground: Clipart || Text ———

mdpi
Image File: [ C:\Users\Marcelo Junion Dawnloads\Terre e
helpi

[ Trim Surrounding Blank Space
Additional Padding:
<

Foreground Scaling: Center

xhdpi
Shape Square || Circle
Background Color
hdlpic

@ < Back Next » Finish Cancel

Estas telas deixe como estdo e clique em “Next >” e a proxima clique em “Finish”

2 New Android Application | X 2 MNew Andraid Application |
Create Activity

i Blank Activity -
Select whether to create an activity, and if so, what kind of activity. Creates a new blank activity with an action bar,

Create Activity

Blank Activit
Blank Activity with Fragment

(M
Empty Activity

Fullscreen Activity

e ey Activity Name8 | MainActivity |

Mavigation Drawer Activity (fJemmean Layout NameB| activity_main |

Tabbed Activity

 The name of the activity class to create

Blank Activity

Creates a new blank activity with an action bar.

@ < Back Next > st Cancel @

< Back Next > T



Esta deve ser a tela inicial do Eclipse:
Clique no icone do Android (apontado na figura), e escolha a API 17

Clique na opcédo “Nexus One” e escolha a opgdo: Generic > 3.7” WVGA...

& workspaceAndroid - <Android> - helloWorld/res/layout/activity_main.xm| - Eclipse - X
File Edit Refactor Navigate Search Project Run Window Help

A RENRET W= iRl S R S AT e A e

| o | g | @

{8 Backage £ 50 mFicbolorer = B [J] MainActivityjava | @ activity_mainaml 5 =g » =g
E e ¥ « ——Paette —— ) v [F4] Relativelayout
v 7 helloWorld w || Palette -] @ '| 0 Nexws One " 8 " # AppTheme > ‘ TextView - “Hello world!"
> (B sic (= Form Widgets P ‘ —
MainActivity = - 20 -
> &8 gen [Generated Java Files] —p—— @ MainActiity - | @ v | i
>\ Android 422 _
£ assets seon Button st B & | D& aaaa®
; Z@b‘" OFF ¥ CheckBox v
v e
> (= drawable-hdpi jSSjf=xtipisis
(= drawable-Idpi (3 Layouts
5 (= drawable-mdpi (] Composite
> (= drawable-xhdpi ) Images & Media
y g rrawatble-xxhdpi ~
v (= layou =
X activity mainmi £3 Transitions
> (= menu () Advanced
5 (= values (] Other
5 values1 Custor Views
> (= valuesv1a s Lbrary 1 Properties PlE| 8|
- A - Graphical Layout | =] activity_mainmi|
[ Snippets 52 5 ¥ = O | mGerenciadorde Dispositivos B LogCat [ Console 52 (8] Problems m Signing and Keys =a
BREB E-0-
DDMS

[2016-@7-85 @@:43:51 - DeviceMonitor] Adb connection Error:Foi forgade o cancelamento
[2816-67-85 @@:43:52 - DeviceMonitor] Connection attempts: 1

<N properties>

! Android SDK Content Loader lm
Sua tela de edicdo deve ficar assim:

[J] MainActivity.java |ci] activity_main.xml X] |
4 . Palette — -
o | s -] @ e <] 8 | rwe <
(= Form Widgets | ® MainActivity v| 0-‘ 17 -
Tenview Large Medium A
| aaalaq

Small  Button  Small

OFF + CheckBox v
[ Text Fields
[ Layouts
[ Comy
(] Images 8 Media
[ Time & Date
[ Transitions
] Advanced
(] Other
Custom & Library Views

Graphical Layout | = activity_main.xml




Conecte seu smartphone Android na porta USB do computador.

Depois clique com o bot&o direito do mouse sobre o nome do projeto, escolha a opcéo:

Run As > 1 Android Application.

Seu “Hello World” deve aparecer no seu smartphone!

2 workspaceAndroid - <Android> - helloWorld/res/layout/activity_main.mi - Eclipse - %
File Edt Refactor Source Navigate Search Project Run Window Help
e~ BEIO- -0 Q@O e me [uick Access] || g | [<androie> | &'
I8 PackageE.. 12 [WFileBolorer = O MainActivityjava il activity_mainxml 53 = O = Outiine ® v=a0o
New 2 ~ [ RelativeLayout
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